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Abstract

This text is part of the introduction to
a Masters-level course in ‘Planning and
Managing the Use of Space for Aquacul-
ture’ made by the AquaSpace project. It
introduces the use of Remote Sensing in
Marine Spatial Planning and site selection
for aquaculture. Brief case studies illus-
trate the aquacultural utility of satellite re-
mote sensing of the coastal waters of the
Algarve, the northern Adriatic Sea, and a
bay in northern France; a case study in
Nova Scotia illustrates the use of low alti-
tude imaging. An exercise involves the use
of the ESA SeNtinel Application Platform
(SNAP) software.

This document may be cited as: Cristina,
S., Fragosa, B., Icely, J. & Grant, J. (2018)
Remote Sensing for Marine Spatial Plan-
ning and Aquaculture, v.4. Aquaspace
project document, 17 pp. Sagaremisco,
Portugal.
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1 Unit Study Guide

This text was written during the H2020
Aquaspace project (2015-2018, contract no.
633476) for a Masters-level course in ‘Plan-
ning and Managing the Use of Space for
Aquaculture’. The course consists of a
number of units; this unit provides an in-
troduction to the use of Remote Sensing in
marine spatial planning for aquaculture.

The unit comprises a text (the document
you are now reading), a set of slides, re-
quired further reading, and some exercises.
The text complements the slides, which can
be used as the basis for a class-room lecture.
The reading provides details of case studies.
The exercises illustrate some of the methods
used in processing remotely sensed data

The learning outcomes for this unit are
to be able to

• demonstrate an understanding of Re-
mote Sensing of the marine environ-
ment and its use for the spatial plan-
ning of Aquaculture;

• explain and critically discuss at least
one application of Remote Sensing for
aquacultural site selection or manage-
ment;

• apply skills in the processing of re-
motely sensed data, using at least one
freely available software package

2 Remote Sensing

Remote sensing is the science of obtaining
information about objects or areas from a
distance, typically from aircraft or satel-
lites. Remote sensors collect data by de-

tecting either passive or active energy that
is reflected from Earth.

Passive sensors respond to external
stimuli in the form of natural energy
that is reflected or emitted from the
Earth’s surface. The most common
source of radiation detected by passive
sensors is reflected sunlight.

Active sensors use internal stimuli to col-
lect data about Earth. For example,
a laser remote sensing system projects
a laser onto the surface of Earth and
measures the time that it takes for the
laser to reflect back to its sensor.

Early passive sensors were essentially
cameras, and these are still used for exam-
ple to provide the basis of the maps used
by Google etc. Sensors for sea-surface tem-
perature or ocean colour mostly use a scan-
ning mechanism, whereby visible and near-
IR light from strip of planetary surface is
imaged along an array of photodiodes, usu-
ally after splitting into several colours plus
infra-red. A picture of the land or sea is
built up as the satellite advances along its
track.

There are numerous technical challenges
in interpreting data provided by sensors on-
board satellites. These include compensat-
ing: for the signal absorbed or added by the
atmosphere; for the influence on upwelling
light leaving the sea surface by the reflec-
tion from the bottom in shallow waters; for
the absorption and scattering effects of var-
ious suspended and dissolved water com-
ponents; for the influence of the water it-
self (IOCCG, 2000; Pozdnyakov and Graßl,
2003); for the rapid changes in signal at the
land-sea boundary; and for the roughness
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of the water surface. These influences on
water-leaving light have to be corrected by
‘sea-truthing’ of the remote sensing mea-
surements against observations from ships
or moorings before they can used to de-
rive the water products from remote sens-
ing measurements (e.g. chlorophyll a con-
centration, suspended particulate matter)
(IOCCG, 2000).

3 Missions and sensors

Airborne remote sensing of ocean colour has
a long history. In his book, ‘The Open
Sea’, Hardy (1956) refers to “a sharp line
separating the green water of the English
Channel from the deep blue of the Atlantic”
that he observed from the air in 1923. In
the early 1970s oceanographers used sens-
ing of sea-surface temperature, based on
infra-red emission measured by low-flying
aircraft, to fix the locations of tidal mix-
ing fronts in coastal waters (Simpson and
Hunter, 1974). Aircraft sensing was soon
extended by images (Simpson et al., 1978)
from satellites flown by the US agencies
NASA and NOAA. The discovery of these
fronts changed understanding of the physi-
cal and biological dynamics of seas on con-
tinental shelves (Holligan, 1981).

The first ocean colour sensor, the CZCS,
was flow by NASA between 1978 and
1986, and allowed mapping of chlorophyll in
coastal waters, such as the North Sea (Holli-
gan et al., 1989). It was followed by the Sea-
WIFS sensor carried on the SeaStar satel-
lite (1997-2010), and then by the MODIS
sensor carried on several NASA satellites,
including EOS PM-1 (now Aqua) launched
in 2002. Increasing numbers of spectral

bands allows better estimation of the ‘opti-
cally active constituents’ in seawater, espe-
cially chlorophyll in nearshore waters where
the optical signal is made complicated by
that from suspended solids and dissolved
‘yellow-substances’ from freshwater.

A large number and variety of Earth ob-
servation satellites are currently in orbit,
placed there by government agencies and
private enterprise, and serving a variety of
purposes: including: military; weather fore-
casting; observation of land and sea. We
focus here on European sensors measur-
ing properties of coastal waters relevant to
aquaculture.

The European Space Agency (ESA) was
founded in 1975. Envisat was launched
2002 into polar orbit, and ceased func-
tioning in 2012. Sensors included MERIS
(MEdium Resolution Imaging Spectrom-
eter, measuring Earth reflectance in 15
bands of visible and near-infrared light).
The subsequent Copernicus programme
comprises a sequence of Sentinel missions,
each with paired satellites in a variety of
orbits.1

Sentinel-1 is a polar-orbiting radar imag-
ing mission, with the first satel-
lite launched on the 3rd April 2014
(Sentinel-1A) and the second on the
25th April 2016 (Sentinel1-B);

Sentinel-2 is a polar-orbiting multispec-
tral imaging mission covering mission
covering land as well as coastal waters,
the first satellite was launched on 22nd
June 2015 and the second on the 7th
May 2017;

1 Notice the distinction between programme,
mission, platform (satellite or aircraft) and sensor.

https://oceancolor.gsfc.nasa.gov/SeaWiFS/
https://oceancolor.gsfc.nasa.gov/SeaWiFS/
https://modis.gsfc.nasa.gov/about/
https://www.esa.int/Our_Activities/Observing_the_Earth/Copernicus/Overview4
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Sentinel-3 is a polar-orbiting multispec-
tral imaging mission with observations
focusing on the oceans to include sea-
surface topography, temperature and
ocean colour; the latter uses OLCI (the
Ocean and Land Colour Instrument).
The 3A satellite was launched on the
16th February 2016, with Sentinel-3B
planned for launching in April 2018.

4 Optically Active Con-

stituents

The Optically Active Constituents (OAC)
of seawater are the components that scat-
ter, reflect, or absorb underwater light, thus
contributing to the amount and colour of
sea-leaving radiance. They are:

seawater itself

phytoplankton pigments especially
chlorophyll but including carotenoids
and phycobilins

SPM or Suspended Particulate Matter,
both living and non-living

CDOM or Colour Dissolved Organic
Matter or ‘gelbstoff’

These interact in complex ways to change
the colour, amount and angular distribu-
tion of light, as photons penetrate into the
ocean (e.g. Bowers et al., 2000; Devlin et al.,
2009). They also affect the small fraction of
photons that is diverted from a downwards
course and so leaves the sea in an upwards
direction. It is by comparing the colour and
amount of sea-leaving radiance with that of
sunlight falling on the sea-surface, that it is

possible to estimate the concentrations of
the OAC.

Doing so requires complex calculations,
combining measurements of light at several
wavelengths, after correction for absorption
and scattering in the atmosphere through
which a satellite views the sea.

5 Remote Sensing and

Aquaculture

Remote sensing can provide information
about the distribution in space and time
of many properties relevant to aquaculture.
These properties include

• chlorophyll concentration, allowing es-
timation of food for shellfish and ob-
servation of the occurrence and spread
of Harmful Algal Blooms;

• sea-surface temperature, which con-
trols the growth rate of organisms

Although the costs of launching and
maintaining satellites is high, they can be
spread over many users. In addition, some
data from satellite remote sensing is in the
public domain, providing a low-cost way for
developers and planners to plan, monitor,
manage and rationally exploit marine re-
sources.

The remainder of this text, and the corre-
sponding slides, exemplify some of the uses
of remotely sensed data for the management
and spatial planning of aquaculture and the
monitoring of environmental conditions rel-
evant both to aquaculture and to marine
ecosystem health in general. The exercises
suggested in section 10 and appendix A pro-
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vide an introduction to obtaining and pro-
cessing such data.

6 Case Study: Algarve

The expansion of aquaculture is a strategic
priority for the Portuguese government to
improve the use of the extensive exclusive
economic zone occupied by Portugal (Gov-
erno Portugal, 2013). Marine Spatial Plan-
ning, involving the linking of Remote Sens-
ing images with Geographical Information
Services (GIS), has been used to define ar-
eas off the Algarve coast that are available
for developing aquaculture (Fig. 1). This
development has to comply with national
and EU legal requirements for coastal ar-
eas. These include

• the Marine Strategy Framework Di-
rective (MSFD), aiming to prevent
the deterioration of the coastal and
oceanic ecosystems by requiring mon-
itoring for, and maintenance of, Good
Environmental Status (GES);

• the Maritime Spatial Planning Frame-
work Directive (MSPFD), aiming to
regulate the human uses of these wa-
ters.

Christina et al. (2015) used Algarve
coastal waters, near Cape Saint Vincent
and the town of Sagres, as a case study
to test how MERIS Algal Pigment Index
1 (API1) could contribute to the mon-
itoring for the Good Environmental Sta-
tus(GES). The MERIS product extracted
was the API1 that corresponds to the to-
tal concentration of chlorophyll a and its
degradation products.

	

 

Figure 1: Image showing the location of
areas available for offshore aquaculture in
blue; offshore areas currently under use in
green; offshore artificial reefs in brown and
white; and fish ponds on land in brown and
white (Source: www.eaquicultura.pt).

The satellite data were obtained from
MERIS Level 2 Full Resolution (FR) and
Reduced Resolution (RR) satellite im-
ages, with a spatial resolution of 290
m × 260 m and 1.2 km × 1.04 km,
respectively. They were analysed, and
API1 extracted, with the Basic ERS and
ENVISAT (A) ATSR and MERIS Tool-
box (BEAM version 4.9; www.brockmann-
consult.de/cms/web/beam).

The results shows that MERIS API1
product decreased from inshore to offshore,
with higher values occurring mainly be-
tween early spring and the end of the sum-
mer, and with lower values during winter.
By using the satellite images for API1, it
was possible to detect and track the de-
velopment of algal blooms in coastal and
marine waters (Fig. 2) that are food for
shellfish but also have the potential to pro-
duce toxins from Harmful Algal Blooms.
The study demonstrated the usefulness of
remote sensing for supporting the aqua-

http://www.eaquicultura.pt/
http://www.brockmann-consult.de/cms/web/beam/
http://www.brockmann-consult.de/cms/web/beam/
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Figure 2: MERIS Reduced Resolution im-
ages of Algal Pigment Index 1 (API 1) show-
ing the development of an algal bloom between
February and March 2012 in the coastal waters
of southern Portugal. Higher algal pigment
concentrations shown in red. The inset zooms
in on Cape St Vincent. Source: Christina et al.
(2015).

culture economy that is developing in this
study area and for the implementation of
the MSFD and MSPFD.

7 Case Study: Adriatic

Valentini et al. (2016) created a map of the
suitability of different parts of the northern
Adriatic Sea for the farming of sea-bass and
sea-bream. They used remote sensing, in-
sea measurements, and models to provide
information on the spatial distribution, and
seasonal variation, of water characteristics
important for fish-farming. The data ob-
tained from satellite sensors were sea sur-
face temperature (NASA MODIS and ESA
Copernicus products) and chlorophyll and

other OAC - from ESA MERIS).

The paper does not record the software
used for the mapping, but the computa-
tional method seems to be that of a pixel-
by-pixel binary analysis. For each pixel
in the map, it was determined whether
it showed space available for aquaculture
or already assigned to another activity;
whether the annual temperature range was
suitable for fish growth; whether concentra-
tions of OAC exceeded thresholds; whether
water currents were above threshold val-
ues.2

The resulting map (Fig. 3) shows that
the most suitable areas for fish farming
were offshore and in the eastern part of the
northern Adriatic. The western Adriatic
was strongly influenced by the discharge
of the Po river, with nutrients that stimu-
lated phytoplankton growth and so resulted
in chlorophyll concentrations above accept-
able limits for sea-bass and sea-bream.
These high concentrations, however, make
the western Adriatic particular suitable for
the cultivation of filter-feeding shellfish, as
explored by Brigolin et al. (2017).

Brigolin et al. (2017) studied the poten-
tial area for aquaculture along the coast
of the of the Emilia-Romagna Italian re-
gion (Northern Adriatic Sea) particularly
for offshore shellfish culture of the Mediter-
ranean mussel (Mytilus galloprovincialis).
The study assessed: (i) if the establishment
of new farms in deeper areas, beyond the
3 nautical miles would be beneficial for the
activity, and if suitable to introduce new
longline technology; (ii) the introduction of

2 Unit 5, ‘Introduction to AquaSpace integrat-
ing tools’ explains pixel-based analysis in more de-
tail.
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Figure 3: Feasibility analysis for fish aqua-
culture in northern Adriatic Sea. Green re-
gion is suitable and free of other activities.
Source: Valentini et al. (2016).

a new species, such the Pacific oyster (Cras-
sostrea gigas); and (iii) the risks for a farm
because of storm events, particularly, in less
sheltered off-shore areas.

Taking these three points into consider-
ation, the methodology used to assess the
suitability of the site for shellfish was the
Spatial Multi-Criteria Evaluation (SMCE),
which provided the framework to com-
bine mathematical models and operational
oceanography products. Intermediate level
criteria (ILC) considered in the analysis
included optimal growth conditions, envi-
ronmental interactions, and socio-economic
evaluation (Fig 4).3

Making use of resources provided by re-
mote sensing and operational oceanogra-
phy in site selection overcame the scarcity
of data for model application. The use of

3 The ‘BlueFarm’ tool developed and applied by
Brigolin et al. is similar to the ‘AquaSpace Tool’
described by Gimpel et al. (2018) and introduced
in unit 5.

environmental parameters provided by the
remote sensing sensor MODIS (Moderate
Resolution Imaging Spectroradiometer) be-
tween 2003-2012 (e.g. Sea Surface Temper-
ature (SST) and concentration of Chloro-
phyll a) were used in the dynamic models
of the present study. The non-linear ef-
fects of the different environmental param-
eters were integrated over the duration of
the farming cycle.

The results of the SMCE showed that the
whole coastal area between 0 and 3 nauti-
cal miles was highly suitable for farming of
mussel, while the area comprised between 3
and 12 nautical miles was divided between
the highly suitable northern part, and the
less suitable southern part.

In addition, seven different scenarios of
development of shellfish aquaculture indus-
try were explored. The introduction of oys-
ter farming did not change dramatically the
degree of suitability for shellfish in the area.
The results highlighted that: (i) the growth
potential in this area was high; (ii) the space
with suitability index > 0.5 increased when
prioritizing the optimal growth condition
criteria, and (iii) the socio-economic crite-
rion was the most restrictive of the ILC.

The results from Brigolin et al. (2017)
show that remote sensing can help iden-
tify zones for sustainable aquaculture in
the Mediterranean Sea, where the space
for these activities is becoming increasingly
limited in coastal waters.
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Figure 4: Information flow, and framework
adopted in the SMCE. Colours mark the
different Intermediate Level Criteria (ILC):
(i) ‘optimal growth’ (orange); (ii) ‘environ-
mental interactions’ (red); (iii) ‘socio eco-
nomic evaluation’ (green). Constraints are
shown in blue. Source: Brigolin et al.
(2017).

8 Case Study: Mont St-

Michel bay

Mont Saint-Michel Bay (North Brittany)
was used as a case study by Thomas et al.
(2011) to assess the potential of this marine
ecosystem for shellfish aquaculture and to
evaluate its carrying capacity. This study
clarified the response of exploited species to
environmental variations using robust eco-
physiological models and available environ-
mental data. It simulated the response
of blue mussel (Mytilus edulis L.) to the
spatio-temporal fluctuations of the environ-
ment in this study area by forcing a generic
growth model based on Dynamic Energy
Budgets (DEB) with satellite derived en-
vironmental data (i.e. temperature and
food).

The sea-surface temperatures were taken
from nightime infra-red emission measure-
ments by the NOAA-18 satellite, and the

chlorophyll concentrations were calculated
using the OC4 algorithm from the ocean
colour (sea-surface reflectance) measure-
ments made by the NASA SeaWiFS.

The model was applied over nine years
on a large area covering the entire bay
and the simulations provided an evaluation
of the spatio-temporal variability in mus-
sel growth and showed the capacity of the
DEB model to integrate satellite-derived
data and to predict the variability of spa-
tial and temporal growth of mussels. In
addition, seasonal, inter-annual and spatial
growth variations were also simulated. The
results showed a strong link between food
(satellite-estimated chlorophyll) and mussel
growth.

9 Case Study: Nova Sco-

tia

This case study concerns the use of low-
altitude aerial photography from balloons
and drones to visualise and map features in
the vicinity of farms.

Delineation of marine habitat types and
boundaries is essential to several manage-
ment concerns facing aquaculture, mostly
related to siting of farms. First, some habi-
tats are specific to other activities such as
fishery grounds, i.e. hard or vegetated bot-
tom may be lobster habitat. Separation
of aquaculture from these activities might
lead to avoiding conflicts with other users.
Second, some habitats may be sensitive
(e.g. eelgrass beds) and avoided to mini-
mize near-field influences such as ammonia
streams from fish farms.

A challenge to resolution of these habi-
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tats is their coverage by water and there-
fore in-availability to many remote sens-
ing techniques. Bathymetric lidar is an
exception but this method is largely ori-
ented only to quantifying depth. In con-
trast, ocean colour of the upper water col-
umn is a longstanding approach to quanti-
ties such as chlorophyll and turbidity, but
these are temporally variable, and usually
not indicative of benthic habitats. One so-
lution to these issues arises via in-water re-
mote sensing using echosounding. However,
given the emphasis on airborne remote sens-
ing in this report, we detail a study of inter-
tidal habitats where the substrate is fully
exposed to airborne imaging. The signifi-
cance of this approach can be related most
easily to intertidal bivalve culture, although
the following example was not in an aqua-
culture area.

The conceptual basis for this research
arises from landscape ecology (Zajac, 2008)
wherein the size, patchiness, and arrange-
ment of the landscape as a mosaic is quan-
tified. Arising from terrestrial ecology, this
approach is more developed where the land-
scapes are visible. In addition, faunal prop-
erties are associated with landscape struc-
ture, i.e. use of meadows and forest by bird
species.

Fundamental to this discipline are land-
scape metrics that are derived with respect
to single patch characteristics (e.g. area to
perimeter ratio), components of the patch
population (spatial distribution, connec-
tivity), and landscape quantities (patch
diversity, fragmentation). Although a de-
tailed explanation of landscape statistics is
beyond the scope of this summary, an excel-
lent introductory text is Gergel and Turner
(2017). Software used to calculate land-

scape indices includes freeware Fragstats
(www.umass.edu/landeco/research/fragstats).

A feature present in shallow waters is
marine vegetation, usually seaweeds or sea-
grasses. Fauna are often associated with
vegetated bottoms, as nursery grounds or
adult habitat, and seagrasses are known
as sensitive habitat relative to ecosystem
health. In the following example from Bar-
rell and Grant (2015), we illustrate how
remote sensing was able to detect inter-
tidal features to map habitat. Fig. 5 shows
the intersection of eelgrass (Zostera ma-
rina) and blue mussel (Mytilus edulis) beds
in Halifax Harbour. We have emphasized
marine plants, but bivalve reefs are signif-
icant biogenic features that provide a vari-
ety of ecosystem services. Remote sensing
via a helium blimp was used to capture the
images, but recent developments in drones
have made this older technique less relevant
for thus type of work. Image manipulation
was used to highlight each habitat. It is ob-
vious that the eelgrass grows as distinct fea-
tures with repeating patterns. Other parts
of the seagrass meadow are more continu-
ous. The bivalve bed has more subtle patch-
iness. In this study, images captured at dif-
ferent times were used to describe changes
in the eelgrass patches via landscape statis-
tics.

The integration of landscape ecology into
the FAO’s Ecosystem Approach to Aqua-
culture is only in its initial stages, but con-
tinued applications in remote sensing will
encourage progress. Consideration of the
far field involves understanding the distri-
bution of habitats and potential interac-
tion with farm sites. A systematic ap-
proach for characterizing and describing
habitats is necessary, and likely achieved

https://www.umass.edu/landeco/research/fragstats/fragstats.html
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through methodologies developed for land-
scape ecology. Remote sensing in underwa-
ter habitats remains an important compo-
nent requiring further research.

Figure 5: Aerial images of intertidal eel-
grass and bivalve beds in Halifax Harbour.
Source: Barrell and Grant (2015).
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10 Exercises and SAQ

Exercise

The exercise involve the use of SNAP (Sen-
tinel Application Platform) software to ex-
amine a Sentinel-3 image obtained from
EUMETSAT. It is detailed in Appendix A.

Further reading

Study one of the papers associated with the
Case Studies:

Algarve : Christina et al. (2015) (Open
Access);

Adriatic : Valentini et al. (2016) or
Brigolin et al. (2017) (both Open Ac-
cess);

Mont St Michel : Thomas et al. (2011);

Nova Scotia : Barrell and Grant (2015).

Self Assessment Questions

The SAQs that follow test your achievement
of the learning outcomes and help you think
actively about the points raised in this lec-
ture. No answers are given. The (paren-
thetical) numbers refer to sections and the
letters to appendices.

1. What satellite data would help an
aquacultural planner or developer to
find a favourable environment for the
cultivation of mussels? (7)

2. How are optical measurements made
by a satellite converted to maps of
chlorophyll concentration? (4)

3. What useful information was gained
by using remote sensing to monitoring
aquaculture concessions in the coastal
waters of the Algarve coast and in the
bays of Nova Scotia? (6, 9)

4. What were the contributions of remote
sensing data to the case studies in the
North Adriatic and Mont Saint-Michel
bay? (7, 8)

5. Describe the main steps of the method
for obtaining a processed image of
Chlorophyll-a concentrations. (A)
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Appendices

A Use of SNAP with

Sentinel-3 data

SNAP is the ESA Sentinel Application
Platform that provides analysis of the sci-
entific data from the ERS-ENVISAT mis-
sions, the Sentinels 1/2/3 missions and a
range of national and third party missions.
Remotely sensed images are stored as arrays
of data relating to pixels in maps. The ex-
ercise involves data that have already been
subjected to some processing, to correct for
atmospheric changes to the sea-leaving sig-
nal and to convert the latter into variables
of interest, such as sea surface temperature
(SST) or – in the present exercise – the phy-
toplankton photosynthetic pigment Chloro-
phyll a (Chla). SNAP allows such data ar-
rays to be explored and manipulated at dif-
ferent processing levels.

The exercise will have been completed
when the student has obtained at least one
chlorophyll image for a coastal region of
their choice.

A.1 Install SNAP

Install the SNAP software
from the ESA toolbox site at
step.esa.int/main/toolboxes/snap, which
provides guidance. Chose the ‘Sentinel
Toolboxes’ and then follow the normal
practice for your computer’s OS to install
the programme. Note where it was placed.4

4In the case of Mac OS X, it is most likely in
Applications/snap/bin.

A.2 Get Sentinel-3 data

Although the SNAP app includes the abil-
ity to access ESA data as one of its func-
tions, it is suggested, here, that the student
visits the EUMETSAT site and downloads
data independently of SNAP. In some cases
this will require a user name and password.5

A directory or folder should be set up to
hold the (large) files before they are loaded
into SNAP.

Tutorials are available from the SNAP
website at step.esa.int/main/doc/tutorials.
Or, go directly to YouTube for How to Vi-
sualise Sentinel 3 Data. As shown in this
video,

• log in to the EUMETSAT site at
coda.eumetsat.int/#/home;

• select region of interest on the map
that is presented, and in the search cri-
teria menu select OL 2 WFR from ‘Prod-
uct Type’, OLCI from ‘Instrument’,
and L2 from ‘Product Level’, to get
Sentinel-3 Level 2 Full Resolution wa-
ter and atmosphere geophysical prod-
ucts from OLCI;

• you may be presented with many data
sets, each from one pass of the satellite;
identify the data set you want;

• download the data, which will be pro-
vided as a zip file: decompress it and
store the resulting folder in the loca-
tion you have identified for these data.

5 In the case of EUMETSAT, a new user can set
up an account when first visitng the web site.

http://step.esa.int/main/toolboxes/snap
http://step.esa.int/main/toolboxes/snap
http://step.esa.int/main/doc/tutorials/
http://step.esa.int/main/doc/tutorials/
https://www.youtube.com/watch?v=3PjTwEMlCMs
https://www.youtube.com/watch?v=3PjTwEMlCMs
https://coda.eumetsat.int/#/home
https://coda.eumetsat.int/#/home
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A.3 Open data in SNAP

Sentinel-3 products are provided as a collec-
tion of files contained within a folder. The
folder name is the actual product name,
ending in .SEN3. Each folder contains
a metadata file named xfdumanifest.xml

and at least one netcdf-file. Each netcdf-file
contains a subset of a Sentinel-3 product’s
content.

There are several ways to open a Sentinel-
3 product within SNAP. Use this one:

• Choose File → Open Product,

• navigate to the xfdumanifest.xml file
in your downloaded folder, and click
Open ;

• the name of the folder will appear in
the Product Explorer window, with
subfolders that include Bands;

• ctrl-click or right click on the folder
name to bring up a menu;

• select Open RGB Image Window , ac-

cept Tristimulus profile, and click

OK to bring up an image in SNAP’s
right-hand window.

The result may look different from that
in the video; a cloud-covered image, for ex-
ample, will be mainly white.6 Continue as
follows to output a chlorophyll image:

• in the Product Explorer window, →
Bands → CHL → CHL OC4ME

• ctrl-click or right click on the file
name to bring up a menu;

6If the image is cloud-covered, it will be desir-
able to return to EUMETSAT for another data set.

• select Open Image Window to dis-
play the chlorophyll image;

• select (in main menus) Layer→ Layer

Manager;

• in the Layer Manager window select
Masks → WQSF Isb CLOUD; close LM
window;

• select (in main menus) View → Tool

Windows → Colour Manipulation;

• In Colour window, select Table and
click on colours to change the colour
scale displayed for chlorophyll.

By this time, your SNAP screen should
look something like Figure 6. The choro-
phyll image can be exported using the menu
generated by ctrl-click or right click .
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Figure 6: Screen grab from SNAP run-
ning under Mac OS X, showing an image
centered on the Strait of Gibraltar on 16
November 2017
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B NASA OceanColor

site

The NASA OceanColor Web site provides
access to NASA data from a variety of mis-
sions. If you use that link to enter the site’s
front page, chose Data → Level 1 and 2

browsers. Or follow the instructions be-
low to see global maps of chlorophyll con-
centration or sea-surface temperature for
a selected month and year, derived from
MODIS.

• Go to NASA Ocean Color site
page at oceancolor.gsfc.nasa.gov/cgi/
browse.pl?sen=am

• set options to to CHL , MODIS

aqua and day ;

• select a month (in this case, August)
and year (in this case, 2017), to display
a global map for that month;

• set option to SST for a temperature
map;

• if you want to do more, use the help
for guidance.

This NASA web page also provides access
to older data, including those from SeaW-
iFS (select MLAC) and CZCS.

https://oceancolor.gsfc.nasa.gov/
https://oceancolor.gsfc.nasa.gov/cgi/browse.pl?sen=am
https://oceancolor.gsfc.nasa.gov/cgi/browse.pl?sen=am
https://oceancolor.gsfc.nasa.gov/cgi/browse.pl?sen=am
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Galparsoro, I., Gubbins, M., Miller, D.,
Murillas, A., Murray, A. G., Pınarbaşı,
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